BEFORE

AFTER

Transcribing can be paneful.
It doesn’t half to be.

Transcribe. Edit. Collaborate.

Automated Transcriptions, Video Search , and Captions

Digital Anarchy
Smar t tools for creative minds.

DigitalAnarchy.com
Transcriptive .com

Transcriptive: Table of Contents
Transcriptive Contents
Keyboard Shortcuts						6
Navigation							6
Capitalization						6
Line Merging/Splitting					6
Punctuation Shortcuts:					6
About This Manual						7
Installation							8
Mac Demo:							8
Windows Demo:						8
Your Serial Number						9
What is Transcriptive?						10
How it works? 							10
What are the costs?*						11
Which Speech Algorithm Should I Use?			
11
System Requirements						13
Transcription Basics and User Interface				

14

Launching Transcriptive					14
First Thing...							14
Signing Up with Transcriptive-AI and Speechmatics		
14
Can I use Facebook or YouTube captions?			
15
Speech Engine Setup						15
Critical Things to Know						17
Clicking on The Transcriptive Panel				
17
Load Transcripts: 						17
Accuracy: 							17
Undo/Redo (especially Mac users)			
17
Maximum Length of transcript: 				
18
Closed Captions: 						18
Edit Mode vs. Tracking Mode				
18
Splitting and Merging					19
Selecting Video/Audio to Transcribe				
19
Transcribing A Sequence					19

© 2019, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: Table of Contents
In/Out Points 						20
Batch Transcribing						20
Batch Files							20
Batch Folder 						20
Batch Project 						20
Transcriptive User Interface					21
The Top UI Bar						21
Main Menu							21
Speech Engine Setup					21
Speaker Management					22
Change Only 1 Speaker Line				22
Delete Transcript						23
Delete Speech Analysis 				23
Batch Transcribing 						23
Job Management						23
Speech Service Settings 					24
Display							24
Proxy Server						24
Whitelisting Transcriptive Servers for Firewalls		
24
Help			
				25
About		
					25
Lock Sequence Button					25
IMPORT Button/Dialog					21
Speech Analysis						21
Plain Text							26
Text Transcripts with Timecode				27
Timing Per Word checkbox				
27
How does Timing Per Word work?			27
SRT		
						29
JSON							30
Moving Transcripts form One Machine to Another
30
Transcriptive/Speechmatics				31
TRANSCRIBE Button/Dialog Box				32
What We Tell You						33
Options							33
Languages							33

© 2019, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: Table of Contents
Speaker Identification					34
ALIGN Current Text					34
Message and Notification Field				35
Notification Menu 					35						
Account Menu						36
Login/Register		 				36
Jobs
						36
My Dashboard						36
Account Settings						37
Undo/Redo							37
Group/Sentence View					38
Punctuation Bar						39
Transcript Window						40
Speaker Identification Column				40
Timecode Column						41
Bottom Navigation Bar					42
Playback and Cursor Controls				
42
PLayback Speed						42
Sync to Playhead						42
Export							43
Plain/Rich Text Format				
43
JSON
						44
Sequence Markers						44
Include Speakers					44
Seconds Between Markers				44
Clip Markers						45
Speech Analysis						45
Working with Closed Captions					46
Character Encoding					46
Captions Standard						46
Caption Type						46
Exportable Caption Formats					46
SRT, VTT							46
SMPTE, SCC, MCC					46
EBU-STL, SMI						46

© 2019, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: Table of Contents
Save Button

						47

Search								48
Search in The Transcriptive Panel				
48
Using “Quotes” to Search			
		48
Find & Replace						49
Text Edit Window						50
There are two editing modes in Transcriptive.			

50

Editing vs Trancking Mode				

50

Tracking Mode						50
Here are the keyboard shortcuts: 				
51
Navigation						51
Capitalization						51
Line Merging/Splitting				
51
Punctuation Shortcuts:					51
Delete Line							52
Plaback Speed Button					52
Edit Mode							52
Adding Missing Words					53
Using Transcriptive Captions in Premiere			 54
Aligning Existing Transcripts: Syncing Transcripts to Audio

55

(adding timecode to a text file)
Importing A Text File			

			55

Troubleshooting section 					57		
How to Get The Best Results from Transcriptive		
57
Recording Your Audio					57
The Microphone						57
Background Noise						57
Noise Reduction Software					58
Talent That Can Enunciate					
58

© 2019, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: Install & Requirements
Keyboard Shortcuts
These shortcuts are available in Tracking Mode for easy editing. Learning to use these can
make basic editing much faster. Especially when combined with increasing the Playback
Speed to 1.5x or 2x.
Navigation
Play/Stop:		
Next Word:		
Previous Word:		
Next Sentence:		
Previous Sent.:		
Next Speaker:		
Previous Sp.:		

Spacebar
Right Arrow
Left Arrow
Alt/Option+Right Arrow
Alt/Opt+Left Arrow
Alt/Opt+Shift+Right Arrow
Alt/Opt+Shift+Left Arrow

Capitalization
Make Upper case: Up Arrow
Make Lower case: Down Arrow
Line Merging/Splitting
Merge with line above: 		

Alt/Option + Up Arrow

Split sentence and make new line:

Alt/Opt + Down Arrow

Punctuation Shortcuts:
Period:			.		Left Single Quote:
‘			
Comma:		
,		
Right Single Quote: Command/CTRL + ‘
Question Mark:
?		
Left Double Quote:
Shift + “
Exclamation Point:
!		
Right Double Quote: CMD/CTRL + Shift + “
Colon:			:		Semi-Colon:		;
Left Parenthesis:
(		
Right Parenthesis:
)
Delete Word: Backspace/Delete

Delete Punctuation: CMD/CTRL+Backspace

To enter ‘Edit Mode’: Enter/Return

To exit ‘Edit Mode’: ESC or Enter/Return
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About This Manual
While the manual is a good resource, we recommend checking out the videos on Transcriptive to
really get an understanding of how it works. Often it’s easier to show something than to try to explain it
with words, especially with something that’s visual to begin with.
However, it can be hard to go into lots of detail in a video, so this manual usually provides more info
than you’ll find in the tutorial videos. The videos and manual are designed to complement each other.

Here are the tutorial videos, they’re all 8 minutes or less:
Installation and Activation
https://www.youtube.com/watch?v=C88lpddR1rw
Editing Transcripts and Keyboard Shortcuts
https://www.youtube.com/watch?v=dWl5qXvGQb4
Requesting New Transcripts
https://www.youtube.com/watch?v=IpjsYi091aI
Caption Formats
https://www.youtube.com/watch?v=4OVSVTbtST0
Conforming The Transcript to An Edited Sequence
https://www.youtube.com/watch?v=2eogcyMYmHw
Merging Transcripts (Combining Sequences or Adding A Clip to An Existing Sequence)
https://www.youtube.com/watch?v=o7utnBf_aL8

7
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Installation
You can always download the most up-to-date version of Transcriptive from our Demo page. Your serial number will activate
the demo.

Mac Installer:
https://digitalanarchy.com/demos/psd_mac.html
Download the .dmg file and run the Installer that’s on the dmg.

This will install the Transcriptive panel and associated files into:
Macintosh HD/Library/Application Support/Adobe/CEP/
It will also install the FLAC exporter into:
Macintosh HD/Library/Application Support/Adobe/Common/Plugins/7.0/MediaCore/Digital Anarchy
Once the installer finishes, it’ll bring up the Digital Anarchy Registration page. Please fill out the registration and close
the installer.
Restart Premiere Pro and Transcriptive should show up in Premiere under Windows>Extensions>Transcriptive
If at some point you wish to uninstall Transcriptive completely (this is sometimes helpful in troubleshooting problems with a new
version), run the Un-Installer.

Windows Installer:
https://digitalanarchy.com/demos/psd_win.html
Open the .zip file and launch the Transcriptve_Installer.exe. If you are updating or upgrading, you’ll be asked if you
want to uninstall Transcriptive. Click OK to run the un-installer. (highly recommended)
Click through the installer, agreeing to the license terms. The installer will automatically select the correct directory,
don’t change this unless you have an unusual system and you know where the panel should go.
This will install the Transcriptive panel, Premiere Power Search panel and associated files into:
C:\Program Files\Adobe\Adobe Premiere Pro CC 2017\CEP\extensions
It will also install the FLAC exporter into:
C:\Program Files\Adobe\Common\Plug-ins\7.0\MediaCore\Digital Anarchy
Once the installer finishes, it’ll bring up the Digital Anarchy Registration page. Please fill out the registration and close
the installer.
Restart Premiere Pro and Transcriptive should show up in Premiere under Windows>Extensions>Transcriptive
If at some point you wish to uninstall Transcriptive completely (this is sometimes helpful in troubleshooting problems with a new
version), run the Installer, click OK to uninstall and then cancel the Installer before it re-installs the plugin.

8
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Your Serial Number
After purchasing your plugin, you should see an email with the Subject: Your Serial Numbers for
Order #XXXXXX
Look for the pink highlighted text in the email. Your serial number will be directly below.
Transcriptive will ask you for the serial number when you first run it within Premiere Pro.
If you have any problems, you can always contact us at cs@digitalanarchy.com or call 415-2876069

9
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What is Transcriptive?
Transcriptive is a new way of automatically transcribing video and audio. It makes it
simple to search the video, create subtitles, closed captions, and more. We allow you to
use two different Artificial Intelligence/Machine Learning services, Transcriptive-A.I. and
Speechmatics, to achieve unprecedented automatic accuracy. Why two? It makes it more
cost effective as you can choose the appropriate algorithm for the quality of your audio. The
two differ in cost and accuracy… see the How It Works section for complete details.
Transcriptive-A.I. is the more accurate of the two, but Speechmatics is also
accurate and a bit less expensive.
Once the transcript is processed it then becomes available in Premiere to be edited,
searched, saved out to markers, or exported as a caption file. You can search the text either
in the Transcriptive window, Premiere’s metadata panel, or the PowerSearch panel making it
easier than ever to find where something was said in your video.
You can also import an existing transcript and use the Align service ($0.02/min) to
sync that to the audio! Transcriptive will add time code to every word, allowing you to easily
search the text and jump to the corresponding place on the Premiere timeline. So if you have
a transcript from another A.I. service or a human service this works great.
Exported files can be taken into any other application or used in Premiere Pro. Common uses
are for closed captions, subtitles, and SEO for YouTube.

How it works
Transcriptive will save a mixdown of the audio tracks in the active sequence to a lossless
FLAC audio file. You can do each sequence individually or do multiple clips/sequence via
Batch Processing. You select your sequence, set in and out points if necessary, open the
Transcriptive panel and click TRANSCRIBE.
If you’re batch processing, select the appropriate Batch command and select your files.
You’ll then be asked what Speech Engine you want to use, Speechmatics or Transcriptive.
You’ll need to sign up for those services on their websites and enter your credentials into
Transcriptive. You only need to sign up for one of them but we recommend testing both.
The Transcriptive service is a bit more expensive but will usually have higher accuracy than
Speechmatics. Especially for punctuation.
If you’re importing an existing transcript and want to use the Align feature, the Transcriptive
service is less expensive at $0.02/min.

10
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What are the costs?*
As of this writing (April 2019), the costs were as follows:
Speechmatics (Based in the UK, so this is in Pounds): 6p for the first minute, 1p for every 10
seconds after that. As of April 2019, that makes it about $.07/min.
Transcriptive AI: $0.12/min. This will usually be the most accurate service. We’re constantly
testing an array of speech-to-text services and will use whichever is currently best. The service
we use may change based on several factors including whether Speaker Identification is
turned on or what language you choose.
Transcriptive Human: $1.50/min. Transcriptions done by a native speaker transcriptionist. 24
hour turnaround. Includes timecode per word, just like the A.I. transcripts. This is guaranteed.
If it doesn’t meet your standards, we’ll redo it.
Align (adding timecode to an existing transcript): Both services do this. Speechmatics is
~$0.04/min and Transcriptive is $0.02/min. Usually there is no difference between the two
so we recommend using the Transcriptive service as it’s cheaper.
* The DigitalAnarchy.com or Transcriptive.com websites will show the most up to date pricing.
(we try to keep the manuals up-to-date but it doesn’t always happen)

Which Speech Algorithm Should I Use?
If your audio is poorly recorded, there’s a lot of background noise or heavy accents, you may
want to consider using the Transcriptive-Human service. A.I. has it’s limits and the poorer the
recording the worse it’s going to do.
As for the AI services, Transcriptive-A.I. will usually be the most accurate, especially if you
consider punctuation which Speechmatics currently doesn’t do. We’re constantly testing an
array of speech-to-text services and will use whichever is currently best based on the settings
you choose. The service we use may change based on several factors including whether
Speaker Identification is turned on or what language you choose. This is a pay-as-you-go
service, so you just pay for the minutes as you use them. So it’s a pretty easy option.
Speechmatics will also give you very good results. It has about 96% accuracy on clean
audio. It also doesn’t do punctuation other than periods. It’s less expensive than the
Transcriptive option, but you’ll need to sign up on their website. This is pretty easy and then
you can enter in your credentials into the Transcriptive Preferences. However, you need to
Pre-pay for the minutes you plan to use.
If you have a lot of background noise or accents, Transcriptive-A.I. is probably your best
bet. It’s almost always going to be the most accurate with that type of audio. Speechmatics is
great for clean audio but the accuracy falls off more steeply as the audio quality gets worse.

11
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If you’re just using the speech-to-text to allow you to search your video and jump to where the text
is spoken, Speechmatics is a good choice. Yes, it’s somewhat less accurate but if you’re just trying
to search a lot of video it’s a good option as it’s a bit cheaper than the Transcriptive-A.I.
If you’re creating captions and you need 100% accuracy, the less accurate the A.I. is, the longer
it’ll take you to clean things up. So Transcriptive-A.I. or even Transcriptive-Human is probably
what will work best.
Of course, we strongly suggest you run a few tests on your own video footage with varying
audio quality to see the results yourself. We’ve found the above to hold true for the vast majority
of tests we’ve run. However, your tests, with your audio, will tell you which service is best for you
as there are plenty of exceptions. For example, Speechmatics will often handle accents a bit better
than Transcriptive A.I. as much of their training data comes from the UK and EU.

12
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System Requirements
Premiere Pro 2015.3 or later. Adobe added more robust panel support in 2015.3 and we
need that functionality. We always support the most recent version of Creative Cloud, so
Transcriptive should work whenever a new version is released.
We support Windows 8 and above; Mac OS 11 and above. It may work on earlier versions
but we can’t offer support for those.
Transcriptive requires an internet connection if you want A.I. transcripts. If you do not have
an internet connection but need A.I. transcripts you’ll need to use a different computer. See
pg 30 for more information on moving transcript and project files. You can also use a Proxy
Server if you have that set up.
Internet is not necessary if you’re importing existing human made transcripts or importing an
existing caption file.
If you plan to use either Speechmatics or Transcriptive, you must create an account with them
and enter your credentials into the Speech Engine Setup section.

13

© 2019, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: Intro & Basics
Transcription Basics and User Interface
Launching Transcriptive
You can launch Transcriptive by going to the Premiere Pro task bar at the top of your screen
and selecting:
Window>Extensions>Transcriptive
This will open the Transcriptive panel. Feel free to dock the panel anywhere in the Premiere Pro
workspace. You can also leave it as a floating window.

First Things First...
The first thing you’ll need to do is to enter in your name, organization, and serial number to
register your Transcriptive license. If you’re using the Trial, you’ll need to get a trial license by
going to digitalanarchy.com/transcribe-video/transcriptive.html and clicking on TRY.
Next, you’ll need to enter in your login credentials in Speech Engine Setup area of the main
menu. You need to set up at least one speech service to use Transcriptive.

Signing Up with Transcriptive A.I. and Speechmatics
Transcriptive A.I. : You’ll need to create an account on Transcriptive.com. Go to the Account
menu in the Transcriptive Panel and click Register. This will take you to App.Transcriptive.com
where you can set up an account and enter in a credit card number.

Transcriptive Panel 				

14
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After creating the account, go back to the Premiere panel and login. You should now see
Transcriptive as an option in the Transcribe dialog.

Speechmatics: Just go to their website and create an account. Once the account is created
go to the Account tab and you’ll see the info needed to login from Transcriptive (see the
next page for a screenshot). Very easy. You get 60 minutes free to start. After that you
need to purchase a block of credits. 6 credits = 1 minute. Speechmatics charges by every
10 seconds, so if you transcribe 2m20s, you’ll use 14 credits. (2min (12 credits) + 20sec (2
credits))
You should be all set! Go forth and transcribe!

Can I use YouTube or Facebook to get free transcription?
Yes. This blog post explains how to do both. YouTube is easy,
Facebook...
Beauty
Boxnot so much:
https://digitalanarchy.com/blog/art-technology/downloading-the-captions-facebook-oryoutube-creates/

Speech Engine Setup
Transcriptive uses two different Speech Services and these need to be set up before you can
use the plugin.
For Transcriptive A.I., all you need to do is log into your Transcriptive.com account. Nothing
else is needed and there’s no tab for it in Speech Engine Setup.
For Speechmatics, you can enter in your credential information by going to the Transcriptive
Main Menu and selecting Speech Engine Setup.
Once you open Speech Engine Setup you’ll see areas to enter in your login credentials for
Speechmatics (You’ll need to sign up for Speechmatics first. See the section prior to this for
more info).
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In addition to your User ID, you need to enter in the API Key. This can be found in your
Speechmatics Account tab. Log into Speechmatics and go to your Account. You should see it
as follows:

Copy the User ID and API key and paste them into Transcriptive.
Once all that is done, this is the only time you’ll need to open Speech Engine Setup unless
your password changes (which we recommend doing periodically).

16
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Critical Things to Know
Clicking on The Transcriptive Panel
In order for Transcriptive to work, you have to click on the Transcriptive panel. If you just select
your sequence and hit play, Transcriptive won’t do anything. This is a limitation of Premiere.
You have to select the Transcriptive panel and hit play from within Transcriptive otherwise
Transcriptive won’t have any idea what Premiere is doing. Transcriptive is technically a
separate app running within Premiere. It will communicate with Premiere but not vice versa.
So control Premiere from within Transcriptive, it won’t work otherwise.
Loading Transcripts:
If you’ve requested a sequence to be transcribed from a speech service, Transcriptive will
automatically populate the edit window with your transcript when it’s finished. If you’ve used
a batch option to transcribe one or more clips, the Transcriptive panel will automatically pull
the transcript from your clips metadata when you create a new sequence with said clip. If
you have placed a clip with speech analysis metadata into an existing sequence, go to the
Transcriptive main menu and select:
Import Transcript > Speech Analysis
Transcriptive will then pull all the speech analysis from your active sequence and form a new
transcript that reflects your sequence. IMPORTANT: Make sure you have ‘Merge Transcripts’
selected or you could lose edits you’ve already made! (See page 57 for more info on that)
** Some older video tutorials will reference Load Transcript. This is no longer necessary **
Accuracy:
Both Transcriptive A.I. and Speechmatics are very accurate. However, background noise
and unclear speaking can make it harder for the speech services to figure out what’s being
said. The less noise you have and the better your talent enunciates words, the higher the
accuracy will be. Make sure your talent is mic’d, speaks clearly and any background
noise is minimized. Talent that has a heavy accent or is off mic will get transcribed with less
accuracy (sometimes significantly less) than talent that is mic’d and well spoken. Regardless,
Transcriptive A.I. is usually the better Speech Service, especially with recordings that have a
lot of background noise. However, we definitely recommend doing some tests with your own
audio.
Undo/Redo (especially Mac users):
You can also use Control+Z for Undo and Control+Shift+Z for Redo.
NOTE: On the Mac it’s also Control+Z as a Premiere panel can’t use Command+Z as
Premiere uses it and, on the Mac, the panel is viewed as the same as Premiere itself.
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Maximum Length of transcript:
Both Speech Services support transcripts of any length. However, very long transcripts can
affect performance.
Complete info about Captions can be found on Page 46 and 54.
Open Captions:
To create open captions in Premiere, we recommend you export the transcript as SRT. You can
then import that into Premiere if you need to make small adjustments using the Captions panel,
or if you want to export them baked into your video. You can also use SMPTE or VTT.
Closed Captions:
To create closed captions in Premiere, you need to export the transcript as either SMPTE-TT,
SCC, or MCC. You can then import them into Premiere if you need to make small adjustments
using the Captions panel, or if you want to export them baked into your video.

Editing Text (complete info on editing the transcript is on pages 50-53)
First Off (since this is a common question): Pressing Enter allows you to edit text and pressing
Enter again (or ESC) exits out of Text Edit mode. The Spacebar plays the video (make sure
the panel is highlighted). The details are explained below, but remember: the Enter key!
Edit Mode vs. Tracking Mode
Still blotchy, needs more smoothing.

There are two editing modes in Transcriptive. More details: Pgs 51-53 but here are the basics.
By default you’re in Tracking Mode. If you press the spacebar to play your video, a yellow
highlight will move from word to word as it’s spoken. In Tracking Mode you can’t edit
the words, however you can delete them or add punctuation with the Punctuation Bar or
keyboard shortcuts. It’s a VERY fast way of doing certain edits. If you just need to add
some punctuation and capitalize some words, you can do it all very quickly with keyboard
shortcuts.
For example, the keyboard shortcuts work on the highlighted word. If you highlight the word
‘attention’ and click the period key (.), a period will be added to ‘attention’ and the next word
will be capitalized (e.g. ‘attention. The’). Likewise, you can select the word ‘wednesday’ and
click the Up Arrow and it’ll be capitalized. Just select the word, hit one key and keep playing
back. Very fast and efficient.
However, if you need to actually edit the text, then you need to go into Edit Mode.
You enter Edit Mode by clicking <Enter> or <Return> on Mac, and you exit Edit Mode
by clicking <Enter> or <ESC>.
18
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Once you’re in Edit Mode, you can edit text as if you were in a word processor. You can
position the cursor anywhere you want and just start typing.
When you first enter Edit Mode, the word that was highlighted in Tracking Mode is selected.
This makes it easy to replace. Just type the new word. This is very common, as the Speech
Services will frequently get a word slightly wrong. For example, you might get ‘lean’ instead
of ‘keen’. So it’s often fastest to enter Edit Mode, type out ‘keen’, exit Edit Mode and keep
playing back.
The buttons on the Punctuation Bar don’t work in Edit Mode.
Once you’ve mastered switching between Tracking Mode and Editing Mode and know the
keyboard shortcuts in Tracking Mode, you can edit your transcript incredibly fast. You can go
even faster if you set the Playback Speed to 1.5x or 2x (That’s the button on the Bottom Bar in
the lower, right corner).
Splitting and Merging
Also in Tracking mode you can Split and Merge sentences or paragraphs.
Since Transcriptive isn’t a normal word processor, you can’t just use <Enter> to create a new
paragraph or DELETE to combine paragraphs. Split and Merge are the equivalents.
To Split, use Control+Shift+Down Arrow. This will create a new paragraph. The word the
highlight is on will become the first word in that paragraph.
To Merge, use Control+Shift+Up Arrow. This will merge the sentence your highlight is on, up
into the previous paragraph.

Selecting Video/Audio to Transcribe
Transcribing A Sequence
If you’re transcribing a sequence, Transcriptive will transcribe whatever audio is in the active
sequence you have selected. So if you’re looking at the timeline of MySequence, that will be
the audio that gets transcribed. If you have multiple tracks of audio, Transcriptive will do a
mixdown of ALL the tracks and send that file to the Speech Services.
This is great if you have dialog on a couple tracks. Both tracks will get transcribed. However
if you have dialog on one track, music on another track, goats braying on another track, etc.,
etc…. that’s not so great. Mute the music and the goats before transcribing your dialog. You’ll
get much better results.
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In/Out Points
Transcriptive will honor IN and OUT points when transcribing. So if you want your entire
transcript transcribed or just a portion of it, make sure the ‘Sequence Length’ matches what
you’re expecting. If it says ‘5 minutes’ and your sequence is 30 minutes, there’s a problem. It
might be the IN/OUT points.

Batch Transcribing
There are multiple ways of batch transcribing. Let’s discuss.
Ultimately they all do the same thing: transcribe multiple clips and put the entire transcript into
the Speech Analysis section of Premiere’s Metadata panel for each clip. This means you can
search the metadata of each clip in the Source window to find any text in the clip you are
looking for. If you drop the clip into a sequence, Transcriptive will use the metadata to build
the transcript, so you don’t incur additional charges from the speech services. It’s very cool if
you have a bunch of clips you want transcribed.
When you batch transcribe, Adobe Media Encoder gets launched so Premiere doesn’t get
tied up while all the clips get transcribed. If you have a lot of clips that could take a while and
we didn’t want Premiere to become unusable while waiting for the transcripts to get back.
Batch Files
This will bring up a dialog letting you select multiple files to be transcribed. This is more or less
the same as any Open dialog you’ll see.
Batch Folder
This will bring up a dialog letting you select a folder. Every video/audio file in that folder will
be transcribed.
Batch Project
If you have all the files you want transcribed imported into Premiere, create a bin named
‘Transcriptive’(with a capital “T”). Place all the files you want transcribed into that bin.
When you select Batch Project, Transcriptive will take all the files in that bin and transcribe
them. Once that is done, you can move the clips out of the Transcriptive bin. There are some
Premiere limitations that prevent us from just allowing you to randomly select files in your
project. So this was the best workaround we could come up with, but we realize it’s not ideal.
Once you’ve selected your files, you’ll see the Transcribe dialog box. See Page_ for more
details on that.
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Transcriptive User Interface
The user interface is divided into five sections:
1- Top bar with the Menu, Transcribe button, and Status field
2- The main text area for editing the transcription
3- Speaker Identification column showing speakers (this only shows if the speakers were
identified)
4- Timecode column
5- Bottom bar with the Export options

The Top Navigation Bar

The top bar in the UI has many critical functions. On the far left you have the Main Menu
designated by three horizontal bars, Login for Transcriptive.com, the Transcribe button,
and the Status window. The lower portion of the bar has tools related to workflow and text
formatting.

Top Nav> Main Menu
This is your control panel of sorts. Speech Engine Setup and Preferences are located here.
You can Batch Process files using the three options. You can also manage transcripts here.
Main> Speech Engine Setup
Please refer to pages 14-16 for instructions on how to sign up and set up for either
Speechmatics or Transcriptive-A.I.
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Main> Speaker Managment
You can add, change or delete the names of the speakers in your transcript using Speaker
Management. This is useful for when exporting paper transcripts, or grouping your transcript
by speaker. By default the Speech Services return ‘Speaker 1’, ‘Speaker 2’, ‘Speaker 3’,
etc. You can also add/delete speakers here as well. Speaker Identification is probably the
weakest part of the A.I. services, so expect to use this dialog a lot.
Change Only 1 Speaker Line checkbox
With this selected, when you change a speaker in the main UI, it only changes that one line
or transcript.
If this is NOT selected, then multiple lines will be changed. All lines below the one you
change will also change until Transcriptive encounters a line with a different speaker. This can
be convenient if there’s a lot of dialog and one or the other person speaking for a significant
time. It works like this:
Original								Changed
1: Speaker 1		
On Line 2, the A.I. gets it wrong.		
1: Speaker 1
2: Speaker 1		
-------- Change to Speaker 2 ----->		
2: Speaker 2
3: Speaker 1		
Speaker 2 is actually speaking and		
3: Speaker 2
4: Speaker 1		
continues until Speaker 3 speaks.		
4: Speaker 2
5: Speaker 3		
Changing Line 2 will cause 3 & 4 to		
5: Speaker 3
6: Speaker 3		
also change and stop at Line 5.		
6: Speaker 3
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Main> Delete Transcript
Clear out the transcript in the Transcript Window by selecting Delete Transcript in the main
menu. This will permanantly delete any transcript that’s in the Transcript Window, creating a
blank slate for the selected sequence.
*Make sure you have the correct sequence selected! It could make for a really bad
day if you accidentally delete a long, edited transcript!

Main> Delete Speech Analysis
This is a seperate menu item and is not part of the Import dialog. When you select this, it’ll
delete the metadata in the Speech Analysis section from whatever clips are part of the
transcript. This allows you to clear it out if you want to replace it with new transcript metadata
(more accurate, edited, etc). It’s also useful if you want to send the original file to someone
without the text transcript.

Main> Batch Transcribing
Here you’ll find your batch transcription options, three to choose from: File, Folder, and
Project. As discussed earlier on Page 20, Batch File allows you to choose as many files from
Finder/Explorer as you want and Transcriptive will launch Media Encoder to transcode your
files to lossless FLAC audio files. Batch Folder does exaclty what one would assume, allowing
you to choose an entire folder of content to be transcribed in a similar fashion to Batch File.
If you’ve already built out your project and want to transcribe all of your clips, choose Batch
Project. You’ll need to create a new bin in your project window titled “Transcriptive”, with a
capital “T” in order for it to work. Drag all of your clips that need transcribing into that bin,
and be sure that the bin is on the root level of your project window. No bins can exist inside
the Transcriptive bin, only files.

Main> Job Management
Job Management allows you to manage your Speechmatics and Transcriptive jobs. Both
services will save all of your JSON files for up to one month before erasing them. If you
don’t want the services to hold on to your transcripts, you can easily delete them using this
function. If you don’t want Speechmatics/Transcriptive to ever save a JSON file, you can go
to Preferences and select the Delete Files checkbox.
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Main> Preferences
Speech Service Settings
As stated before, Speechmatics/Transcriptive will hold any job of yours for up to 30 days
on the server before deleting it. You also have the abilitly to control whether you want the
services to save your trnascripts at all. If you feel safer not having your transcript saved on
the server, simply check the ‘Delete transcription jobs from server’ box to automatically
delete your transcript from their server.
You can also turn off Speechmatics email notifications if you like.
Other
Here you can decide whether you want Transcriptive to automatically check for new updates,
show drop frame timecode, or change the the time between which Transcriptive auto-saves to
the Premiere project file.
Under “Other” is where you’ll also find all of the file types that Transcriptive can batch
transcode to FLAC via Media Encoder.
Display
In the display portion you’ll find the ability to show clip name in your timecode column as a
quick and easy indicator of what clip you’re at in your sequence.
This is also where you’ll find the option to turn off the on-boarding tutorial that pops up
whenever you open the Transcriptive panel.
Proxy Server
In order to return transcripts from the speech services, Transcriptive must have an open
connection to either Speechmatics or Transcriptive-A.I.. If you’re in an environment that utilises
a proxy server, you will need be sure to open up a connection.
Here you’ll find two options to work with. “Use System Setting” will search for whichever
setting your browser uses to connect to your proxy server allowing you to simply use your
credential as you would for your browser.
The other option is to use Manual Settings. Here you’d enter the proxy server address along
with port number to connect Transcriptive.
If this is all foreign information to you, but you know you’re in a proxy server environment,
have your I.T. person help you out. They’ll know what to do.
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Whitelisting for Firewalls
Here are a list of URLs you may need to whitelist for Transcriptve to work:
digitalanarchy.com
app.transcriptive.com
api.speechmatics.com

TCP 443

Main> Help
The Help section will provide you with links to Keyboard Shortcuts, Video Tutorials, FAQ, this
Manual, and all around general Tips and Tricks.

Main> About
Last but not leaset the Main Menu contains the About section. Here the only pertanent
information is the version of Transcriptive you’re running, whether it’s up to date or not, and of
course the names of our support cats.

Top Nav> Lock Sequence Button
The Lock Sequence button will lock the Transcriptive window to the transcript for a particular
sequence, regardless of what the Active Sequence is, so the transcript doesn’t change.
This is useful if you’re switching between sequences to find clips or other info but you’re only
working on one transcript. If this is not turned on, as you switch sequences Transcriptive will
load the transcript for that sequence. Usually this is great. However, if you’re only working
on one transcript, constantly having Transcriptive load a different transcript can be annoying.
Lock Sequence solves that problem.
To use it, go to the sequence you want to always see the transcript for. With that sequence
selected, click the Lock Sequence button. Now whenever you switch to a different sequence,
you’ll only see the original, locked transcript.
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Top Nav> Import Transcript Button
Use the Import Transcript dialgue to import a variety of file types as well as retrieving transcripts from
Speechmatics, Transcriptive-A.I. and Speech Analysis.

Import> Speech Analysis
Importing Speech Analysis will populate your Transcript Window with any transcript that’s baked into
the metadata of all clips from your active sequence. This is used to create a new transcript that reflects
edits you’ve made to your timeline.
You can view the transcript that’s in Speech Analysis by opening the Metadata panel in Premiere.
Towards the bottom you’ll see the Speech Analysis section. If the selected clip has a transcript in the
metadata you’ll see a block of text there.
If you select Speech Analysis and nothing shows up in the Transcriptive window, open the Metadata
panel and make sure there’s text under Speech Analysis. That could be the problem.
IMPORTANT: If you’ve made edits/corrections to your transcript in the Transcriptive window, you
should Export>Speech Analysis. They won’t be automatically saved. If you Import>Speech Analysis
without doing this you’ll be loading the original transcript that was received from the A.I. service.

Import> Plain Text
This lets you select a plain text file to use as the transcript. Transcripts must be in .txt format. You
can choose from a variety of character encoding but UTF-unicode is native (You can usually leave
Encoding on Auto-Detect and ignore it). If selected, it will also try to identify Speaker tags and
Timecode (see next section).
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Import> Transcripts with Timecode
Timing Per Word checkbox
Transcriptive can now import existing transcripts with timecode and apply unique timecode
per word without sending it away for alignment. As of now only a handful of timecode
formats are readable. If you’re experiencing trouble please reach out to us, it may be that you
have a format that we have yet to add.
For this to work you must have the Timing Per Word checkbox turned On.
How Does Timing Per Word work? It interpolates between timestamps. So the more
frequent the timestamps the more accurate it is.
(You can also have Transcriptive-A.I. or Speechmatics align an existing plain text or
SRT transcript for you if you don’t have timecode or want more accurate timecode than
interpolation. (Please see the Alignment section on pg 55 for more information.)
Continued on Next Page...
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Timing Per Word will add timecode to text that doesn’t have it. It does this by
interpolating between timestamps. For example, if you have this:
06:00 This is a sentence
10:00 That’s timecode
‘This’ would be given a time of 6:00 and ‘That’s’ will get 10:00. What about ‘is a
sentence’? We’ll take the time difference between the two timestamps, 4 seconds and
divide it by 4 (the number of words in ‘This is a sentence’). That’ll give us 1 second.
We’ll ignore ‘This’ because it’s already at 6:00. ‘is’ will be assigned 7:00, ‘a’ is 8:00,
and ‘sentence’ is 9:00. This isn’t going to be quite as accurate as the A.I. but if you
already have a transcript this is a pretty good way of getting timecode. However,
the ALIGN function that uses A.I. is the best way to get timecode for existing scripts,
captions or text.
6:00
This
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Import> SRT (Frequently better than plain text for Timing Per Word)
If you have an existing transcript as a SRT file, you can use the SRT Importer to get
that into Transcriptive. Since SRTs only have timecode for whole lines, the individual
words do not have timecode, unless you have Timing Per Word turned on. You
can still search and jump to where a sentence was spoken, but you can’t do so for
individual words.
However, when Timing Per Word is on, Transcriptive will use the very frequent SRT
timestamps. It’s a great way of adding timecode per word to text that doesn’t have it.
If you want to import captions from YouTube or Facebook, use SRT. Here are
instructions on how to do so: https://digitalanarchy.com/blog/art-technology/
downloading-the-captions-facebook-or-youtube-creates/
One huge advantage of SRT is that the timestamps are very frequent. Usually every
few seconds. This means Timing Per Word is usually very accurate.

Combine Lines to Paragraphs is a cool SRT feature. Usually SRT lines are 32
characters long. If this is turned ON, then the lines will be combined into paragraphs
or sentences if there’s punctuation. It’s a great way of creating a readable transcript
from an SRT file.
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Import> JSON
JSON files are created by Transcriptive to save your transcript. They are also used by the
Speech Services when they generate the transcript. This is what Transcriptive gets when you
request a transcript.
There isn’t a standard JSON format. Currently we only support JSONs from Speechmatics,
Google, Watson and Transcriptive itself. If you have a JSON from another service or
application, most likely it won’t import correctly.
Please email cs@digitalanarchy.com to find out if your application is supported.

Moving Transcripts from One Machine to Another
This also lets you get the transcript on one machine and move it to another. So if your
facility only has a couple machines connected to the internet, you can use them to get the
transcription, grab the JSON file and move it to the machine without an internet connection.
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Import> Transcriptive/Speechmatics
This lets you import a transcript directly from the Speech Services. The dialog looks the same
for Speechmatics or Transcriptive-A.I.
If there’s an internet failure of some sort, this makes it even easier to grab the JSON file. This
shows a list of all the jobs you’ve submitted to Speechmatics. You can select the one you want
to use for the sequence you’ve selected.
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Top Nav> Transcribe
The heart of Transcriptive is the Transcribe button. This is where the magic begins.
Once you’ve selected the sequence you want to transcribe and muted any non-dialog audio
tracks, you’ll press the TRANSCRIBE button.
This will bring up the Transcribe dialog box. You’ll also see this after your Batch files have
been transcoded if you’re Batch Processing clips.

Transcribe> Transcribe Dialog Box
Before Transcriptive sends the audio file off to the Speech Services we need to tell you a few
things and we need to know a few things.
Most importantly, we need to know which Speech Service do you want to use, Transcriptive
or Speechmatics?
Transcriptive-A.I. is usually more accurate than Speechmatics.
So you’ll need to select one or the other. If you have not setup the Speech Services, there’s a
button that will take you to that dialog box. You can’t use Transcriptive without setting up at
least one Speech Service.

What we tell you
First off, at the top of the dialog we tell you how long the audio is that you’re transcribing.
You should check this to make sure that you’re not transcribing 3 hours of video when all you
really want is 15 minutes.

32

© 2019, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: Top Navigation UI
It’ll then give you some info about your account for whichever speech service you have
selected. For Speechmatics, we also tell you the system status. If this is Good, then you
should expect to get your transcription back quickly. If it’s something other than Good, it will
probably be delayed.

Transcribe> Options
Transcriptive-A.I. will usually be the most accurate, especially if you consider punctuation
which Speechmatics currently doesn’t do. We’re constantly testing an array of speech-to-text
services and will use whichever is currently best based on the settings you choose. The service
we use may change based on several factors including whether Speaker Identification is
turned on or what language you choose. This is a pay-as-you-go service, so you just pay for
the minutes as you use them. So it’s a pretty easy option.
Speechmatics will also give you very good results, particularly on clean audio. It doesn’t do
punctuation other than periods. It’s less expensive than the Transcriptive option, but you’ll
need to sign up on their website. This is pretty easy and then you can enter in your credentials
into the Transcriptive Preferences. However, you need to Pre-pay for the minutes you plan to
use.
If you have a lot of background noise or accents, Transcriptive-A.I. is probably your best
bet. It’s almost always going to be the most accurate with that type of audio. Speechmatics is
great for clean audio but the accuracy falls off more steeply as the audio quality gets worse.
Of course, we strongly suggest you run a few tests on your own video footage with
varying audio quality to see the results yourself.

Transcribe> Languages
You can select from 26 languages. We don’t support multiple languages in a single video.
Are all languages transcribed with the same accuracy? Answer: No.
Some languages are less accurate and some will produce results that are little better than
word salad. The more common languages: English, Spanish, German, French, and Japanese
transcribe very accurately in most cases if you have well recorded audio. These are listed at
the top of the Language dropdown.
Less common languages are listed alphabetically after the high accuracy languages:
Swedish, Portuguese, and Italian for example, will probably be less accurate. Most of these
produce results that are useful for searching the video but not for captions. Before doing long
transcriptions, please do some short tests with your language of choice to see if the results are
acceptable to you.
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Transcribe> Speaker Identification
Next, select if you want Speaker Identification and tell us how many speakers
there are. See the Speaker Identification section for more details on this. Identifying
speakers is probably the weakest part of the A.I. services. Transcriptive-A.I. does OK
and Speechmatics is better than nothing, but it definitely requires a lot of clean up.
Transcribe> Align Current Text
If you’re getting a new transcript from one of the speech services, make sure this is
turned off. See the section on Importing An Existing Transcript. Basically this allows
you to take an existing transcript and sync it to the audio, adding timecode to
the existing text. Incredibly useful if you have an existing transcript from a human
transcription service (or other A.I.) but useless otherwise. You MUST import an existing
text file for this to work.
Transcriptive-A.I. is $0.02/minute for this service and Speechmatics is $0.04/min.
Both will produce similar quality results.
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Top Nav> Message and Notification Field
The field in the upper, right corner will tell you the status of your transcription, error messages
or other information about what you’re doing. This also displays for 30 seconds. After that,
the message is moved into the Notification Menu (The ‘Bell’ icon).

The messages you most commonly will see are:
Encoding FLAC file: This means we’re exporting the audio as a lossless FLAC file, which is
what the Speech Services require.
Waiting for Speechmatics/Transcriptve: Once the audio file is sent, we wait for the Speech
Services to respond either with the transcription text file or an error message. Usually this will
take about 1/4th to 1/2 the time of the audio file. So if you send a 10 minute audio clip,
expect it to be done in 2-5 minutes.
Transcription Successful: Transcriptive has received the text file and you should see the
transcription in the Transcriptive panel.
Transcription Failed: This can happen for a number of reasons, including the service being
down. We try to provide helpful error messages but the Speech Services aren’t always helpful
in this regard, so sometimes we don’t know why it failed.

Top Nav> Notification Menu
Shows archived messages after they disappear from the from the Message Field.
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Top Nav> Account Menu
This shows you your options for Transcriptive.com and the Transcriptive Speech Services. You
need to create an account on Transcriptive.com in order to use the Transcriptive-A.I. as that’s
where we manage billing.
It allows you to create an account, login, and logout. You can also view the jobs you’ve
submitted, your dashboard, and account settings.
** If you’re only using Speechmatics, you can ignore this menu. **

Account> Login/Register
If you’re not logged in, you’ll see a Login link and a Register link. Use Login to access your
Transcriptive.com account and Transcriptive-A.I. service. If you don’t have an account, you
can create a free one by clicking on Register.
You don’t have to do this to use the Transcriptive panel. If you only want to use Speechmatics,
you don’t need to create an account on Transcriptive.com. The panel will be fully functional.
However, by creating an account, you can use the Transcriptive Speech Services and you
can send and receive transcripts from producers or clients using the browser version of
Transcriptive. Please see Page _ for more info on working with Transcriptive.com
Account> Jobs
This is the same as going to Main Menu>Job Management. It allows you to see all of the
transcription jobs you’ve placed and reload them if necessary.
Account> My Dashboard
This will take you to your Transcriptive.com dashboard, where you can see how much you’ve
spent, all your jobs and the costs they incurred, change Billing info and other information
about your account.
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Account> Account Settings
Use this to edit basic account settings like Name and Password. If you want to change your
Billing information please use My Dashboard instead as it will allow you to change all the
settings associated with the account.

Top Nav> Undo/Redo

These buttons allow you to undo or redo the last action. You can also use Control+Z for Undo
and Control+Shift+Z for Redo. NOTE: On the Mac it is also Control+Z as a panel can’t use
Command+Z.
Undo/Redo doesn’t work for everything. You can’t undo merging and splitting sentences, for
example. Eventually we’d like to have everything undoable, but for now it’s just text changes,
which should cover most users needs.
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Top Nav> Group/Sentence View

By default when you get a transcript back each sentence has a separate line in the Edit
Window. If Speaker ID was turned on, the speaker is listed for each sentence. This is great if
you want to see the timecode for each line or want to edit the speakers and make sure they’re
correct.

Sentence View
However, having each sentence as a separate line does take up a lot of real estate. If you just
want to go through and edit/check the text it’s usually easier if the text is in one big block as it
would be in a regular word processor. Luckily the Group button lets you do this.
When you click on the group button it will merge all the text together temporarily so you can
edit it more easily. If there are speakers, it’ll group the sentences together by speaker. If there
aren’t speakers, it’ll create blocks of text with about 1000 words each.

Group View
You can click the Group button again to go back to Sentence view and Transcriptive will
retain all the sentence information.
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Top Nav> Punctuation Bar

These buttons let you easily add punctuation in Tracking mode. Just select the word and hit
the button or corresponding keyboard shortcut (the punctuation key on the keyboard, for
example to add quotes, select the word and press the Quote (“) key). This makes it very easy
to add basic punctuation.
The great thing about this is you don’t have to go into Edit mode. Normally you’d have to
enter Edit mode, position the cursor at the beginning of the word, press the Quote (“) key,
move the cursor to the end of the word and press the “ key again. With Transcriptive, as
you’re playing back the audio, you can stop the highlight on the word you want to add
quotes to and press the “ key, then press Control+” and you’re done! Two keystrokes vs. six
keystrokes.
If keyboard shotcuts aren’t your thing, these buttons help out with punctuation while in
Tracking mode.
On the far right of the Punctuation bar you have four more buttons. From left to right they are:
Delete Word. Delete Punctuation, Split Line, and Merge Line. Split/Merge Line makes it easy
for you to separate speakers from when the Speech Service incorrectly assignes the wrong
speaker, or you’d like to separate a sentence for captioning spacing.
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Transcript Window
As you might guess, this is where your tanscript will visually live as you work with
Transcriptive. In the Transcript Window you can edit the transcription. It also highlights the text
as the video plays, allowing you to easily follow the text as you listen to the audio playback.
You can edit with keyboard shortcuts as the video plays or you can go into ‘word processor’
mode by pressing Enter and edit as you usually would with a text editor.
We cover all this in more detail in the Text Editing section on Pgs 50-54. Also check out the
Keyboard Shortcuts section.
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Transcript Window> Speaker Identification Column
If you selected ‘Speaker identification’ when you transcribed, the Speech Services will attempt
to identify how many speakers you have and which text is attributable to each one. Neither
Speechmatics or Transcriptive are awesome at this, and this typically needs a fair amount of
cleanup. Transcriptive-A.I. will usually do a better job however.
The Speaker Column shows which speaker the Speech Service thinks said that particular
sentence.
You can change the speaker by clicking on the dropdown menu and selecting the correct
speaker. You have two options for how it behaves when you do this. You can change one line
at a time OR you can have it change every line below that until it runs into a different speaker.
You can change that by going to the Speaker Management dialog in the main menu. Here’s
how the multiple line mode works:
Original								Changed
1: Speaker 1		
On Line 2, the A.I. gets it wrong.		
1: Speaker 1
2: Speaker 1		
-------- Change to Speaker 2 ----->		
2: Speaker 2
3: Speaker 1		
Speaker 2 is actually speaking and		
3: Speaker 2
4: Speaker 1		
continues until Speaker 3 speaks.		
4: Speaker 2
5: Speaker 3		
Changing Line 2 will cause 3 & 4 to		
5: Speaker 3
6: Speaker 3		
also change and stop at Line 5.		
6: Speaker 3

By default the column will show Speaker 1, Speaker 2, etc. You can change that to real names
by going to the Speaker Management dialog in the main menu. You can also add speakers
there.
Transcript Window> Timecode Column
This shows the start timecode of any given sentence or block of text. In most cases, each word
will have timecode associated with it. As you click on each word, the Time Marker in Premiere
will jump to the portion of the timeline where it’s spoken. The Timecode Column only displays
the timecode for the first word.
If you split (Opt/Alt+Down Arrow) a sentence or block of text, the timecode of the word you
split on will appear in the Timecode column.
Another piece of information you can find in the Timecode column is when a new clip has
started in your timeline. If you see the name of a clip in the timeline column, you know that
every timecode appearing below is in that specific clip until you see the next clip name.
This column is primarily for informational purposes only.
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Bottom Navigation Bar

The lower navigation bar has controls to move around the text, Search field, Replace function,
and the Export dialog. All critical parts of Transcriptive.
Playback And Cursor Controls
The controls right below the text window allow you to move where the highlight is. Especially
when you’re using the keyboard shortcuts, it’s fast and easy to highlight any word. The
controls are:
- to the next/previous word (keyboard shortcut: right/left arrow)
- to the next/prev sentences (keyboard shortcut: Alt/Opt + right/left arrow)
- to the next/prev speaker (keyboard shortcut: Alt/Opt + Shift + right/left arrow)
- Play: Starts playback. The video/audio will play while the highlighted word moves 		
along with whatever is spoken. (keyboard shortcut: Spacebar)
Playback Speed
Lets you set the playback speed to realtime, 1.5x or 2.0x faster than realtime. This is very
useful, especially if the transcript is accurate. You can scan for incorrect words much faster. It
does take a little getting used to, but once you do, it really speeds up editing.
Sync to Playhead
This re-syncs Transcriptive to your timeline playhead. You would use this when you’ve been
scrubbing through your timeline without regard to Transcriptive. Rather than scrolling through
the Transcript Window, press this button for Transcriptive to sync to the current time in your
sequence.

42

© 2019, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: Bottom Nav UI
Export
There’s a lot going on in this little dialog. You can export the entire transcript to a closed
caption file, export it to Premiere’s metadata or markers, or export a plain text file for paper
edits.

Export> Plain Text/Rich Text Format
Exporting paper trancripts can be done easily with Transcriptive. You have the option of
both Plain Text (.txt) and Rich Text Format (.rtf) file types. RTF has more formatting options
than Plain Text, and is recommended when exporting transcripts meant to be looked at by a
human. Plain text works better if you’re going to be importing the file into another system. A
Caption Editor for example. Both file types can be opened in various word processors.
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Export> JSON
These files are mostly for moving the transcript to a different machine with Transcriptive or
backing up the edited transcript. You can just move the entire Premiere project to the other
machine. However if you just want to get the transcription over to the other machine, you can
export out as JSON file and import it on the other end. See pg 30 for more information on
moving transcript and project files.
While these are technically text files, there’s no standard JSON format, so it’s unlikely other
applications will import the JSON saved from Transcriptive.
Export> Sequence
This exports the transcript to sequence markers. You can then search the text via the Markers
panel. This can be very useful if you want to close the Transcriptive panel or if you need
to send the project to someone that doesn’t own Transcriptive. The entire transcript will be
embedded into sequence markers which will show up in both the timeline and Program
window.

When you export you get two options:
Include Speakers: This will include the speaker names in the text of the markers.
Seconds Between Markers: This sets the frequency of the markers. If you set this to 10
seconds, a marker will be laid down about every 10 seconds. Each marker will include
the text that STARTED being spoken in the10 seconds after the marker (to use the above
example). So if you have a sentence that starts at 10:05, another one at 17:15 and a third at
19:20, those three sentences will be included in the marker at 10:00.
But, you know... it’s complicated.
If the sentence that starts at 19:20 is long and the next sentence is at 31:10, no marker will be
laid down at 20:00 as no sentence starts between 20:00 and 30:00. The next marker will be
at 30:00.
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Export> Clip Markers
Clip Markers can be an awesome way of moving the transcript around. Clip Markers are
embedded into the video file, so if you import the clip into a different project or move it to a
different machine, the clip markers (and the transcript) will go with it.
You’ll see these show up ON the clip itself in the timeline. Sequence markers show above the
timeline.
The options are the same as Sequence Markers (see previous poge) and work the same way.
Export> Speech Analysis
Exporting to Speech Analysis puts the entire transcript into the metadata of the clips in your
timeline. If you highlight a clip in your timeline and then switch to your metadata panel you’ll
see the corresponding transcript in the Speech Analsysis field.

Having your transcript baked into your clips metadata allows for Transcriptive to conform
new transcripts based off your sequence edits.
For those of you who prefer editing out of the source panel rather than edting based off of
sequences in the timeline, the Speech Analysis field allows you to easily create in/out point
pertaining to the transcript and then inserting or overwriting into a sequence.
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Export> Closed Captions & Subtitles
Transcriptive can export a variety of closed caption and subtitle files. Each file type has
different restrictions, but overall they do basicaly the same thing. Be sure to inquire about your
final delievery to properly choose which caption file is best suited for you.
In Transcriptive when you export a caption file you’ll be presented with a dialogue box with
options pertaining to your specific file type.
Character Encoding: This allows you to choose which encoding your text will show as. It’s
important to be correct on this otherwise important diacritical marks may come out differently,
or as complete nonsense/gibberish.
Captions Standard: You can specify whether the captions meet the 608 or 708 standard.
Or whether they’re Teletext or Open Captions. Different file formats have different standards.
Caption Type: Let’s you set how many lines you want and how those lines behave... either
pop-up (one caption is replaced by another) or roll-on (the captions scroll up).

Export> Types of Caption Files
SRT: The SubRip file format is common for online video. It’s also a very basic file that can
easily be read and edited in programs like Notepad, Wordpad, TextEdit, etc.
VTT: WebVTT is a caption file for the internet and is a favored file format for YouTube and
Vimeo.
SMPTE-TT: Closed Caption file that suports 608, 708, Open captions, and Teletext. This file
is exported as a .XML.
SCC: stands for “Scenarist Closed Caption”, a file type developed by Sonic. SCC file is
closed caption file for standard definition broadcacting. 608 only.
MCC: is a MaCCaption closed captioning file, and like SMPTE-TT supports both 608 and
708 (SD and HD) closed captioning.
EBU-STL: This caption file is the standard for Eurapean Broadcasting with Teletext and Open
Captions.
SMI: A computer based caption file applicable with many online platforms.
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Save Button
As you may have guessed the Save button saves the changes you’ve made to your transcript
to the Premiere project file. If the button is a shade darker than the Export button next to it, that
means there’s nothing to update and save. If your transcript has saved successfully, the top
right Progress bar will tell you, “Save transcript successful”.
Transcriptive will auto-save any changes you’ve made after 10 seconds of idleness. This
increment can be changed in Preferences found in the drop down Main Menu.
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Search
You can search the transcript to find where a word or phrase is spoken. This only works for the
transcript that’s selected. If you want to search all your transcripts, metadata, and markers,
you can use our PowerSearch panel. PowerSearch will let you scour your entire project and
works incredibly well for projects where all the clips have been transcribed. More info is here:
https://digitalanarchy.com/premiere-search/powersearch.html

Search> Searching in the Transcriptive Panel
The search field allows you to search for words and phrases throughout the transcript of your
active sequence.
IMPORTANT: Using quotation marks around a single word will return that specific word and
not other words that may contain that string of letters. For example putting quotation marks
around the word “the” will only return “the” and not theater.
When using the search function, the number of results will be indicated on the right side of the
search field along with the result your playhead is at (signaled by the red-dotted outline). You
can cycle through your results by using the arrow buttons to the right of the search field or by
using Tab and Shift+Tab.
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Search> Find and Replace
Automatic Speech Recognition software is still very much in its infancy, and because of that
we can pretty much guarantee that there will be mistakes in the transcription, and sometimes
that mistake will repeat throughout your entire three hour interview. And that makes for a very
tedious task of correcting.

Find and Replace allows for the quick and easy correction of repeat offenders. If you notice
that your automated transcript is repeating the same incorrect word you can fix the issue in
one easy step.

First enter the offending word into the Find field, and then add the correct word in the Replace
field.
You’ll then have the ability to Replace All instances of the word, or selectively change
individual instances with the UI buttons found between the two text fields.

49

© 2019, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: Editing Text
Text Edit Window
(For a video explanation: https://www.youtube.com/watch?v=dWl5qXvGQb4 (8 min.)
We’ve already talked a bit about Edit Mode vs. Tracking Mode, but to recap...
The overall goal with this is that you don’t have to take your hands off the keyboard. Usually
you can do everything with keyboard shortcuts. There are exceptions but most of the time, if
you know the keyboard shortcuts, your hands never have to leave the keyboard. This makes
for fast, efficient editing.
There are two editing modes in Transcriptive.
Tracking Mode
By default you’re in Tracking Mode. If you press the spacebar to play your video, a yellow
highlight will move from word to word as it’s spoken. In Tracking Mode you can’t edit
the words, however you can delete them or add punctuation with the Punctuation Bar or
shortcuts. Keyboard shortcuts are critical in Tracking Mode, so it’s worth learning them.
To actually edit the text you need to switch to Edit Mode.
Edit Mode
In Edit Mode you can edit text as if you were in a word processor. You can position the
cursor anywhere you want and just start typing or select text and replace it. Although, again,
hopefully you’re just changing a word here and there and don’t need to move the cursor.
You enter Edit Mode by clicking <Enter/Return> and you exit Edit Mode by clicking
<Return> or <ESC>.

Editing> Tracking Mode
It’s a VERY fast way of doing certain edits. If you just need to add some punctuation and
capitalize some words, you can do it all very quickly with keyboard shortcuts in Tracking
Mode
This is designed to let you easily playback the video and see any transcription errors quickly.
If the transcript is mostly correct you’ll be able to clean it up very quickly. This is why we
recommend Transcriptive-A.I. if you’re going to be using the transcript for captions or subtitles
where you need a perfect transcript. If you can do most of your editing in Tracking Mode,
you’ll be able to move incredibly fast.
For example, the keyboard shortcuts work on the highlighted word. So if you highlight the
word ‘attention’ and click the period key (.), a period will be added to ‘attention’ and ‘so’ will

50

© 2019, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: Editing Text
be capitalized. Likewise, you can select the word ‘wednesday’ and click the Up Arrow and
it’ll be capitalized. Just select the word, hit one key and keep playing back.
Here are the keyboard shortcuts:
Navigation
Play/Stop:		
Next Word:		
Previous Word:		
Next Sentence:		
Previous Sent.:		
Next Speaker:		
Previous Sp.:		

Spacebar
Right Arrow
Left Arrow
Alt/Option+Right Arrow
Alt/Opt+Left Arrow
Alt/Opt+Shift+Right Arrow
Alt/Opt+Shift+Left Arrow

Capitalization
Make Upper case: Up Arrow
Make Lower case: Down Arrow
Line Merging/Splitting
Merge with line above: 		

Alt/Option + Up Arrow

Split sentence and make new line:

Alt/Opt + Down Arrow

Punctuation Shortcuts:
Period:			.		Left Single Quote:
‘			
Comma:		
,		
Right Single Quote: Command/CTRL + ‘
Question Mark:
?		
Left Double Quote:
Shift + “
Exclamation Point:
!		
Right Double Quote: Cmd/CTRL + Shift + “
Colon:			:		Semi-Colon:		;
Left Parenthesis:
(		
Right Parenthesis:
)
Delete Word: Backspace/Delete
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Delete Line
This isn’t a keyboard shortcut, but it’s a shortcut nontheless and is a great way to rid your
transcript of large unneeded portions.

Hovering the mouse over the undesired text will uncover an “X” UI button on the far right of
the Transcript window. Select that button to delete the whole line or paragraph from your
transcript.
At this time Delete Line is most useful for cleaning up a transcript wherein your goal is to
export a paper transcript with only a specific speaker and say, not the off camera interviewer.
It’s best to use this after you’ve exported your transcript to Speech Analysis, this way you can
always bring it back in the future by Importing from Speech Analysis.
Playback Speed Button
Once you’ve mastered switching between Tracking Mode and Editing Mode and know the
keyboard shortcuts in Tracking Mode, you can edit your transcript incredibly fast. You can go
even faster if you set the Playback Speed to 1.5x or 2x (That’s the button on the Bottom Bar in
the lower, right corner). It’s surprisingly easy to listen to a video that’s been sped up by 150%
or 200%. It takes a little getting used to, but once you do, you can fly through the editing
process especially if the transcript is very accurate to begin with.

Editing> Edit Mode
However, if you need to actually edit the text, then you need to go into Edit Mode.
You enter Edit Mode by clicking <Enter/Return> and you exit Edit Mode by clicking
<Return> or <ESC>.
Once you’re in Edit Mode, you can edit text as if you were in a word processor. You can
position the cursor anywhere you want and just start typing. Although, again, hopefully you’re
just changing a word here and there and don’t need to move the cursor.
When you first enter Edit Mode, the word that was highlighted in Tracking Mode is selected.
This makes it easy to replace. Just type the new word. This is very common, as the Speech
Services will frequently get a word slightly wrong. For example, you might get ‘loan’ instead
of ‘alone’. So it’s often fastest to enter Edit Mode, type out ‘alone’, exit Edit Mode and keep
playing back.
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Also, since you enter Edit Mode with the word selected, you can use the arrow keys to go to
the beginning or end of the word. For example, if the speech service returned ‘engage’, you
can click the left arrow to go to the front of it and add ‘dis’ (for ‘disengage’) and then hit ESC.
You could click the right arrow to go to the end of it and type ‘d’ (for ‘engaged’) and then hit
ESC.
So it can be very fast for making quick edits. But it is a full word processor so if you need to
change multiple words or you see something further down that needs to be corrected, you
can move the cursor wherever you need to make those changes.
The buttons on the Punctuation Bar don’t work in Edit Mode.
Adding Missing Words
If you’ve found that the speech service has outright missed a word in your footage/audio,
or the speaker mumbles two words together, you can add the missing word to the transcript.
However, because the speech service was unable to identify it properly, the added word will
not have a unique timecode and must be attached to an existing timecode. Just type the word
nex to the most convenient word and Transcriptive will add the word. Upon playback you’ll
see that now when the tracker highlights this particular area, the highlight will now include
both words to that specific timecode.
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Working with Closed Captions

For more info about exporting Caption or Subtitle files, please see Page 46.
Transcriptive can export a varitey of caption files. Premiere unfortunately won’t allow
Transcriptive to automatically import those files into Premiere. Once you’ve exported
a caption file, you’ll need to import it into your project manually as if it’s like any other
media. In your project you can then drag and drop the caption file onto a video track in the
corresponding sequence.
If you drag a closed caption file into a sequence but nothing pops up in your program
monitor, you’ll need to alter your program panel settings to look for your specific caption file
parameters, e.g. 608, 708, open captions (or you’ll need to enable captions if you haven’t
already). Do this by selecting the wrench icon in the bottom right of the program panel.

Once you can see your caption, highlight the file and open your Captions Panel. Here you’ll
be able to make more nuanced changes than you can with your initial Transcriptive export.
For quick formatting changes be sure to Right/Control+click to Select All captions.
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Alignment of Existing Transcripts
One of the most important things Transcriptive can do is take your existing transcript and sync
it up with the speech in your video. This will add timecode to every word in the text file. If
Transcriptive can’t read your timecode format, or you’d like to have an even more accurate
transcript, this is a great option.
Importing A Text File
For more information about importing Text Files, please see Page 26-28.
Under the Main Menu is the Import Transcript command. Select that and choose the file type
of your transcript. In most cases it’ll be a plain text file but SRT is also a good option. See the
Import section for more details on each of those.
Once the text is in the Transcriptive panel, you need to align it with your video’s audio. To do
this:
- Click the Transcribe button
- Select Transcriptive-A.I. (You can also select Speechmatics but it’s a bit more expensive.
- Check the Align Text button at the bottom of the Transcribe dialog
- Click OK

Transcriptive will then encode your media files and send them to Transcriptive-A.I. or
Speechmatics. The Speech Service will then match the wriiten word of the transcript to your
audio. Alignment costs less than transcription ($.02/min for Transcriptive-A.I. or $.04/min
for Speechmatics) and will attached unique timecode to every word. Please be aware that
we’ve found that alignment often takes longer than transcription. Both services do this equally
well, so choose whichever is cheapest.
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** For very poor audio or audio with a lot of dead air, Alignment may not work.
It does not have to be as good of quality as you’d need for normal A.I. based transcription.
Alignment is much more forgiving than using A.I. to transcribe from scratch. However, you still
need to be able to hear what’s spoken.
A lot of long gaps between dialog (dead air) will also cause problems for the Alignment
service. Sometimes it works fine but it often causes incorrect timecodes.
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Troubleshooting section
How to Get The Best Results from Transcriptive
Transcriptive-A.I. will give you the most accurate transcription, particularly for punctuation and
speaker identification. So if you’re doing captions and subtitles and will be cleaning up the text,
Transcriptive will usually save you time.
Speechmatics is still quite accurate and a bit less expensive. So it’ll work as well.

Recording Your Audio
The higher the quality of your audio, the better the accuracy of the transcript. If someone is well mic’d
in a sound proof room, you’re going to get better results than if you’re using the microphone on your
iPhone on a busy, New York street corner.
The speech services do an amazing job but they can’t overcome garbage audio. Garbage in,
garbage out.
This doesn’t mean it has to be perfect.
In fact, it’s rarely perfect and the transcriptions are still usually excellent (especially from
Speechmatics). However, the closer you follow the below guidelines, the better chance you have of
getting a highly accurate transcript.

The Microphone
A good microphone goes a long way. So if you have your talent speaking into a good mic, even if
you’re on a street corner (maybe not the busiest New York street corner ever, let’s not push it), the
transcript should still come out excellent.
Our favorite microphone is the Behringer Ultravoice Xm8500 Dynamic Cardioid Vocal Microphone.
You can get it for $20 and it’s great. Omni-directional mics pick up more noise. They can be great, the
Sennheiser ME2 lav mic we have is awesome, but good ones are more expensive and, regardless,
they pick up more noise.

Background Noise
The less background noise the better. The quieter you can get the space you’re recording in to be, the
better off you’ll be. However, all background noise is not created equal. White noise (waves crashing,
cars passing) is less problematic than being in a room with lots of people talking.

Noise Reduction
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Do NOT use noise reduction software on your audio. It will make the transcription worse. The AIs are trained with normal
recordings, so the noise reduction software distorts what they’re expecting and the resulting speech-to-text is worse. (Machine
learning works by giving an AI test data that it can learn with. It will do a better job with files that are similar to the files it
learned on. So if it’s been trained with recordings with normal noise, it’ll do less well on recordings that have been manipulated
to not have noise.)

Talent That Can Enunciate
The speech services can handle accents. It’s really not a problem if you have a British, Indian or American accent.
Enunciation on the other hand... that matters. If you’re interviewing a drunk southern boy, the transcription will probably fare
worse than your interview of that English barrister.
Try to get your talent to speak as clearly as possible. Again, it doesn’t have to be perfect. If they speak a bit fast or use a little
slang, it should still result in a good transcription. But the further away you get from clear, well enunciated language, the worse
the transcription is going to be.
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